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1  

1 Customer Release 
Notes 

Introduction 
The Xerox

®
 FreeFlow

®
 Accxes

®
 Controller Firmware Release 15.0 b 240 provides multinational 

software for the Xerox Wide Format 6604/6605 Solution™.  The languages supported are 
English, Deutsch, Español, Francais, Italiano, and Brazilian Portuguese. 

This document presents the following information about the FreeFlow Accxes Controller 
Release 15.0 b 240.  The document applies to LVX, UXC, and UXC-N controllers and for 
simplicity they will simply be referred to as UXC. 

• Release deliverables 

• Recommended configurations 

• Installation procedures  

• Present supplemental information and known issues that are not mentioned in the 
published customer user documentation. 

Feature Keys 
Print and Copy Feature Keys are enabled on the UXC controller by loading the “OS 
Enablement” feature key.   

Additionally, the following functions will be unavailable until the appropriate feature key 
is loaded.   

• DGN printing is enabled with an “Other CAD” feature key. 

• JPEG 2000, PNG, BMP, and GIF printing is enabled with a “Raster” feature key. 

• DWF printing is enabled with the “AutoCAD” feature key. 

• Job Accounting Enables tracking media usage data for print, scan, and copy jobs.  Account 
Management Tool, or some other external accounting tool, is used to assign User Id, 
Account Id, Printer Id associations, and then collects and tallies the stored data from the 
printers). 

• PostScript® – Enables the interpretation of Adobe Postscript®  3™ and PDF files up to 1.7. 

• Disk Image Overwrite – Enables the security options for overwriting image data on the 
hard drive. 

• Scan-To-Net – Enables Scan to Mailbox, Scan to FTP, and Scan to Remote Printer features.  
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• Scan-to-Print – Allows a scanned document to be printed to the system automatically as a 
proof copy. 

• Color Scanning key is only needed on the 6279 as this function is a standard function of 
the 6604 and 6605 solutions. 

• 9-D Speed key for printing on the 6279. 

• Speed Enhancement Turbo II – Enables 4 ips scan speed on the Wide Format Scan 
Solution 

• Speed Enhancement Turbo III – Enables 7.33 ips scan speed on the Wide Format Scan 
Solution. 

• GFI Enablement – Enables communication with a folder using the Generic Folder 
Interface. 

Release Deliverables 

Xerox 6604/6605 Wide Format Solution 

The following executable is provided for the Xerox 6604/6605 Wide Format Solution and 
supports the Xerox Large Format Scan System.  

• LVX, UXC, & UXC-N Controllers:  
LVX_UXC_UXCN_6604_6605_15_0b240.disk.bin (file size = 119,631,465 bytes) 

 

Recommended Configurations 
The following table specifies the RAM requirements for the various systems and configurations 
supported by the FreeFlow Accxes controller. 

 LVX Controller UXC/UXC-N Controller 

System Min Recommend Max Min Recommend Max 

Any System with the following feature 
keys: 

AutoCAD 

Other CAD 

RASTER  

2GB 2GB 3GB 2GB 2GB 3GB 

Any System using Total Accxes 2GB 2GB 3GB 2GB 2GB 3GB 

6604/6605 2GB 2GB 3GB 2GB 2GB 3GB 
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Release Installation 
This version of Accxes (15.0 build 240) requires OS Install CD version 4.4 or higher.  BSP Kernel 
revision 2.6.22.9-61.fc6 or later is also required.  Service is required to upgrade from earlier 
Accxes revisions. 

This version of Accxes has been tested with: 

• 6604/6605 printers running version 1.1.07 firmware and the Large Format Scanner 
running 1.64 firmware.   

Print From USB 

Place the firmware file onto a USB drive and insert into one of the USB ports on the controller 
or UI.  Choose the “Print From Device” service and select the file on the USB drive to request 
that it be submitted/printed.  A status sheet will be printed to indicate that the download was 
successful. 

Accxes Client Tools 

Download the file named “<Controller>_<Printer>_<Accxes_version>.disk.bin”.  A status sheet 
will be printed and indicate that the download was successful. 

Web Printer Management Tool 

Select Utilities > Upload > Upload File.  Use the Browse button to select the 
“<Controller>_<Printer>_<Accxes_version>.disk.bin”.  Click on the “Upload” button.  A printed 
status sheet will indicate that the download was successful. 

UNIX® 

Download the software using LPR with the following command line: 

 lpr –P printername  “<Controller>_<Printer>_<Accxes_version>.disk.bin” 

A status sheet will be printed and indicate that the download was successful. 
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New Features in V15.0 b 240 

No new features.  This release is intended to support Tag 9 scanners on the 
6604/6605 product family. 

New Features in v15.0 b136 

The following features were added across the full breadth of products 
supported by Accxes and do not all apply to the 6604/6605. 

Support for the 7142 Printer 

The 7142 is now supported by the Accxes print server as a printer via the 
customer’s network.  This allows for prints to be submitted through the Accxes 
print server via ACT, drivers, lpr, Web Printer Management Tool upload file, and 
Instant Accxes folders directly to the 7142 printer. 
 
Configuration of the Accxes controller is managed through the Web Printer 
Management Tool as there is no other User interface. 
 
Color printing is supported for the following data formats: TIFF, HP-GL/2, HP-
RTL, JPEG, Postscript/PDF, CGM, and VCGL.  Three print quality modes are 
supported “Fast”, “Normal”, and “Best”  
 
 
Note: To function properly, Accxes requires the 7142 to have version 01.05 
or 01.06 Pro firmware. 

Permanent Job Queue 

The Accxes print server job queue is now preserved across power cycles and 
reboots.  This prevents data loss during power outages and other inadvertent 
shutdowns.  Any active job at the time of system shutdown will be placed in 
the “Hold” queue at power-up.   This allows the system administrator to control 
which jobs get processed first when the system resumes. 

Job Hold Support 

A job can now be submitted to a hold queue or placed on hold for printing at a 
later time.  Jobs can be put on hold or released from either the touch screen UI 
or the Web Printer Management interface. 
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Administrator Managed Queue 

The Accxes print server now supports a mode which puts all incoming jobs on 
hold to allow the key operator to manage what gets printed when.  This mode 
is controlled via the Web Printer Management Tool or the Touch Screen UI. 

Naming of Scanned files 

Users can now name their images prior to scanning their documents.  A simple 
numeric index will allow quick continuous scanning of originals.  Or users can 
enter unique ID’s for each scan.  This support is for all scanning operations 
including “Scan to Mailbox”, “Scan to FTP”, and “Scan to USB” 

Scan to USB Device 

A new feature has been added to the touch screen user interface (6279, 
6604/6605, and 6622) to support scanning from on-board scanners to a USB 
device.  This feature can be accessed by inserting a USB device or selecting an 
inserted device from the “Scan to Mailbox” device list.  A USB device (FLASH 
drive or portable HDD) can be connected via the touch screen UI or directly 
into one of the USB ports on the controller to support scanning.  This allows a 
user to have his files in hand when the scanning operation is complete.   USB 
ports on the controller are high speed ports and have higher performance than 
those on the touch screen UI.  This feature is compatible with the touch screen 
on the 6204 User Interface. 

Print from USB Device 

Another new service of the touch screen (6279, 6604/6605, and 6622) is the 
support of printing from a connected USB device or CD.  The user can browse 
and select a file from the attached device and request that it be printed to the 
local printer.   The settings used are the default print settings as configured on 
the Web Printer Management interface.  This feature is compatible with the 
touch screen on the 6204 User Interface. 

GFI finisher key required for all finishing systems 

We have added the requirement that all finishers be enabled with a new 
feature key.  If the feature key is not present the finisher communication will 
not be activated. 

Support for Wide Format Scan System on 6622 

Legacy users will be happy to know that support for the Wide Format Scan 
System has been added to the 6622 printer.  Users upgrading to a 6622 can 
now keep their familiar scanner for continued use.  (Note: additional 
hardware is required.) 
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Release Notes 
The following information supplements the 15.0 customer user guides. 

IE 6.0 

IE 6.0 only does not display the Total Accxes preview image when using Web Printer 
Management Tool. 

Controller 

Stamp Does Not Appear 

If the user tries to upload a stamp files that contains an invalid format, or if the Accounting 
Mode is set to “Enabled”, no error message will be displayed. The Web Printer Management 
Tool screen will display a message that the file was uploaded successfully and the stamp’s 
filename will not appear in the “Printer Resident Stamps” list. To avoid this situation, set the 
Job Accounting mode to “Optional” before uploading stamps. The Web Printer Management 
Tool has no knowledge of the validity of any file that is sent to the printer. File validation and 
error handling is done on the printer by the FreeFlow Accxes controller. The Web Printer 
Management Tool only reports that the file was sent to the printer successfully. 

Scaling Interaction with “ANY” 

The media size “ANY” will select the best sheet size for an image to prevent clipping.  If a user 
specifies a media size of “ANY” and a scale factor that makes the image too large for any 
sheet size and mismatch mode is set to scale, the controller will select the largest sheet size 
and scale the image to fit on it. If this is not the desired behavior, a specific sheet size can be 
selected, or the media mismatch mode can be set to QUERY. 

Margins May Cause Clipping 

If the margins (TOP, BOTTOM, RIGHT and LEFT) are set to a non-zero value (5mm is the 
default) then that amount of whitespace will be added to the image before placing it on the 
media and could cause part of the image to be shifted off the page, or clipped.  To correct this 
problem set the margins to 0. 

CGM Files and Folding 

Certain CGM files contain rotation commands which can confuse the system when folding.  If 
the title block is not visible or the plot is bypassed and not folded, change the title block 
location to obtain a correctly folded document. 

Manual Feed 

Manual feed media source will be ignored when used with the Accxes 
Client Tools’ page composition feature 

Go to Accxes Client Tools > Job Option tab > Composition tab > Select Overlay Images > Media 
Source drop down menu.  Although “Manual Feed” is listed as a choice of media source for 
page composition jobs, the print job will be treated as if AUTO media source was selected.  If 
an appropriate roll of media is available, it will be printed on that media; otherwise, the job will 
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query until the correct roll media is installed.  In addition, other Media Source selections will be 
treated as AUTO if an appropriate roll of media is available in a different roll. 

InstantAccxes 

When using InstantAccxes folders on an IPv6 network DNS server is recommended and you 
must reference the system directly as shown below: 

• Vista: Start>Run> \\<Controller Name> 

• Linux: smb://<Controller Name> 

InstantAccxes Folders not accessible from Mac® on IPv6 

InstantAccxes folders are not accessible to systems running Mac OS® 10.4 or earlier versions 
on IPv6 networks. 

Web Printer Management Tool 

TotalAccxes copies Setting does not function 

When defining a remote printer for use with TotalAccxes there is a selection for “Copies” which 
is NOT applied to the job and should be ignored. 

Printer Queue – Main Web Printer Management Tool Screen 

The FreeFlow Accxes Controller supports a maximum of 120 active printer jobs in the queue 
and 8 active copy jobs.  If subsequent jobs are sent before the 128th prints, ports will refuse 
connections and there can be scan errors; when there are fewer jobs in the queue, the jobs can 
then be resubmitted or scanned. Additionally, completed jobs will be removed from the queue 
display immediately to make room for the newly submitted print jobs.  To avoid these issues, 
keep the number of active print jobs to under the 128 limit. 

Note 

More than 128 files can be sent from the Document Submit Tool as one print job, 
but all of the files in the print job must have printed before sending subsequent jobs, 
or the jobs will be refused. 

German users only 

Zum Drucken von Etiketten mit Umlauten DRUCKERVORGABEN > DRUCKER-EINSTELLUNG > 
Plot-Etiketten wählen. Anschließend im Dropdown-Menü für Fonts einen der folgenden Fonts 
wählen: HP2 Stick Font Latin - 1 oder HP2 Stick font Latin - 1 – Proportional. 

Large Scaling Factors 

Images set to scale beyond the largest installed roll will not scale beyond the largest width 
unless a specific roll is selected, a specific page size is selected, or mismatch mode is set to 
something other than scaling. This is a behavior that has changed from previous releases (prior 
to 9.0). 

For example: The largest roll installed is 36". Scaling is set to 999%. Submit an ARCH E sized 
drawing (Media Size = Any, Mismatch = Scaling). The drawing will not be scaled. 

In order for the output to exhibit the desired scaling factor, one of the following conditions 
must be met: 
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What to do: 

Set Mismatch Mode to Substitute  

• Request a Media Size of ARCH E via Web Printer Management Tool, ACT, or the Driver 

• Request a Media Size 36" Roll via Web Printer Management Tool, ACT, or the Driver 

HPGL Page – End of File 

If the files are streamed via any port on the system, these are treated as a single job and no 
reset is done between them.  However, if one uses the LPD protocol to send the files one at a 
time, the effect is that the printer is reset after each job. If the “Reinitialize after EOF” is set to 
be on, the FreeFlow Accxes firmware will reset the printing parameters after each plot file that 
is received by a serial port or a parallel port. To reset the HPGL parameters on the Web Printer 
Management Tool, select Printer Defaults > Emulations > HPGL.  Click on the box in front of 
“Reinitialize after EOF”.  Click on the “UPDATE PRINTER” button. 

Default PostScript Page Size 

If a PostScript job does not specify a page size (either by using a compatibility operator such 
as “letter”, or “a4”, or by using the setpagedevice operator /PageSize parameter), the page size 
used is the one specified by the Default PostScript Page Size parameter available via the 
printer user interface, or via the Web Printer Management Tool. 

“Printer has been updated” Message 

If the user presses the “UPDATE PRINTER” button without actually making changes first, the 
Web Printer Management Tool will still return a message that the printer was updated.  The 
Web Printer Management Tool cannot distinguish a page that has been modified from one 
that has not been modified.  This is because of the “stateless” nature of the http protocol and 
the fact that no events are generated (html) when text values are entered or items are 
selected. When the “UPDATE PRINTER” button is pressed, all the data on the form is gathered 
and sent to the server.  If the data is valid, the printer is updated and “The printer was updated 
successfully.” message is returned.  If inappropriate data is sent, an error message is returned.  
To verify valid changes to printer settings, a test print can be printed to view the changed 
settings. 

Scan to Print and Margins 

When performing a scan-to-print operation the scanned image is printed using the current 
printer processing defaults including margins.  If the image scanned is exactly the width of the 
paper, then the processing default margins should be set to zero to prevent the image from 
being clipped or placed on a larger sheet of paper. 

Scaling Shaded Documents 

Scaling documents with error diffused shaded areas should be done in a photo mode to 
produce the best image quality.  Line mode tends to exaggerate the shading dots making 
them more visible. 

Disk Image Overwrite 

Overview 

The Disk Image Overwrite feature has two operations: Immediate and On Demand.  The 
immediate operation overwrites image data on the hard drive immediately after it is no longer 
needed (i.e. When the page has printed).  The On Demand operation cleans the entire disk.  
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Both On Demand Image Overwrite and Immediate Image overwrite feature are configured by 
the system administrator, assuming that the system administrator password is set to a non-
zero value. 

Algorithm 

The overwrite algorithm for both IIO and ODIO conforms to the U.S. Department of Defense 
Directive 5200.28-M (Section 7, Part 2, paragraph 7-202), and is common to all 
WorkCentre/WorkCentre Pros and Accxes controllers.  

The algorithm for the Image Overwrite feature is: 

1. Pattern #1 is written to the sectors containing temporary files (IIO) or to the entire 
spooling area of the disk (ODIO). (hex value 0x35 (ASCII “5”)). 

2. Pattern #2 is written to the sectors containing temporary files (IIO) or to the entire 
spooling area of the disk (ODIO). (hex value 0xCA (ASCII compliment of 5)). 

3. Pattern #3 is written to the sectors containing temporary files (IIO) or to the entire 
spooling area of the disk (ODIO). (hex value 0x97 (ASCII “ú”)). 

4. 10% of the overwritten area is sampled to ensure Pattern #3 was properly written. The 
10% sampling is accomplished by sampling a random 10% of the overwritten area. 

Note 

See Online Help in Web Printer Management Tool for more details about using the Image 
Overwrite feature. 

 

Touch Screen for 6622/6604/6605/6279 Specific Notes 

Overview 

This section is clarification to the existing documentation available for the Touch Screen UI 
which is used on the 6622, 6604/6605, and 6279 systems. 

Scan to Print Taking Too Long 

When scanning documents to a Mailbox, or FTP site and printing them at the same time the 
prints may be slow due to scan processing.  Processing of the scan image takes priority over 
the printing and so the print may be delayed. 

Timer Reset Button 

This button will reset the timer value to the previous setting, NOT to the factory default 
setting. 

Shared Settings 

Many of the settings for Scan-to-Mailbox Scan-to-Remote-Printer and Scan-to-FTP are shared 
and so many of the settings made on one will stay when selecting the other. 

Can’t interrupt multi-page/set operations 

When creating a collated copy set or a multi-page scan file you cannot leave the Service to 
enter another service like machine info to change administration settings.  To allow the user to 
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do so would force an abort of the current scanned job or potentially change a setting which 
should have applied to all pages and so produce an inconsistent set. 

Managing Multi-page document sizes 

When creating a multi-page document it is important to use an appropriate resolution for the 
application.  A 600 dpi scan in full color is 38MB per inch (for 36” wide doc) and even with JPG 
compression will create files which quickly approach or exceed 1GB.  Unless the application 
warrants a high resolution scan, it is recommended that 200-300 dpi be used or limit the 
number of pages to keep file sizes manageable. 

Speeding up Remote Print Times 

When scanning a document to a remote printer it is important to use an appropriate 
resolution for the application.  A 600 dpi scan in full color will take significantly longer to 
process than a 200 or 300 dpi scan.  Unless the application warrants a high resolution scan, it 
is recommended that 200-300 dpi be used to increase productivity.  

Installing and removing feature keys 

The 6279 and 6604/6605 systems must be in an idle state, not in a power-saving state when 
installing or removing feature keys.  In a power-saving state some components are powered 
down and cannot respond to feature key changes. 

Any Sheet page sizes 

When submitting a job where the media size is set to “ANY_SHEET” all standard page sizes will 
be used to identify a good fitting sheet.  Standard page sizes include all ANSI, ARCH, ISO A, 
ISO B, 30x42, 17x25, 22x36 and extended ISO sizes like 297x1189, 297x841, 420x841, 
594x1189, 841x2378. 

Changing settings on Instant Accxes folders 

When settings are changed on Instant Accxes folders, the folder usually needs to be re-shared 
to the network.  This may cause InstantAccxes folders which are open on client workstations to 
become invalid until the user closes the folder and re-opens it. 

Printing Custom Size Documents  

When printing non-standard size documents on the 6279 or 6604/6605 Setting media 
mapping to “Any_roll” and setting mismatch mode to “Scale” produces the best results and 
prevents clipping. 

Web Printer Management Tool Reports Out of Toner Until Next Job 

On the 6279 and 6604/6605 if an out of toner condition occurs the Web Page will report the 
IOT status as out of toner until the next job is processed even if toner is loaded into the 
system.  The printer User Interface will report it correctly. 

TotalAccxes prints extra media to an Accxes driven printer 

When submitting large prints (ARCH E) via TotalAccxes to an Accxes driven printer it may 
produce an oversize print. 

“Please Wait” Message 

Occasionally when inserting one document immediately after another the printer user 
interface will display a “please wait” message until it is ready for the document.  If this 
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message remains displayed for more than a few seconds, remove the newest document and 
re-insert to begin your scan. 

Copying ARCH-E size prints 

To maximize copying of ARCH-E size prints always copy them using the preset output format 
ARCH-E. When copied in synchro mode it is likely that ARCH-E documents will scan as 1220mm 
and will incur unneeded pauses between printing pages. The 6204 IOT will pause between 
pages which are greater than ARCH-E (48 inches 1219 mm) in length for the fuser to come all 
the way back to full temp even if it is in the nominal fuser temperature range. 

Sluggish Response While Scanning 

Occasionally under heavy load, the system, especially the User Interface, has been seen to 
respond slowly.  Response times usually speed up once the active jobs are completed.  If they 
do not a reboot of the system will restore proper operation. 

6604/6605 Specific Notes 

Scanner Fails to Accept Document 

If the scanner fails to accept and scan a document and does NOT display an error message it 
is necessary to open and close the scanner to reinitialize it for continued operation.  The 
scanner may take up to 10 seconds to initialize after closing. 

Copy Template Viewing 

When attempting to view a copy template with “Blue Line” as the original type the system will 
shutdown.  Any other original type will be displayed correctly. 

Enhanced Stitch Support 

Version 15.0 b 136 adds support for stitch skew detection and will report an error if the stitch 
target is NOT inserted correctly. 

GFI Finishing Specific Notes 

Gera Mondial B6 

Due to end of roll conditions or roll switch conditions, the system may appear to be hung or 
unresponsive.  The system can be reengaged simply by pressing the green folder reset button 
on the folder. By pressing the reset button, the system will begin again with the pages 
currently queued. Enhancements have been made to the system to allow for the reset as 
expected.  

Windows® 2008 security settings and TotalAccxes 

 

When using TotalAccxes on Windows 2008 servers, you must make some security setting 
changes to allow for the configuration of remote destinations. One of the following will work. 

1. Enable scripting. 

a. Go to Tools->Internet Options->Security 

b. Click on 'Custom level...' for the 'Internet' security zone. 

c. Scroll down until you reach the category 'Scripting' and set 'Active Scripting' to enabled. 



   

12 Xerox FreeFlow Accxes Print Server Customer Release Notes 

2. Add the site to the trusted sites zone 

a. Navigate to the page you wish to allow to work 

b. Go to File->Add this site to->Trusted Sites Zone 

3. Disable the Internet Explorer Enhanced Security Configuration 

a. Open the Server Manager 

b. Click on 'Configure IE ESC' 

c. Turn off IE ESC for either Administrators or Users as seen fit. 
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Customer Issues Resolved 
The following issues were resolved in 15.0 build 240. 

Issue  Description Problem Resolution 

SPAR 895780730 – DWF 
printing 

A certain DWF file when printed was 
missing most of the line drawings. 

Modified DWF interpreter to better handle 
lines. 

New 6604/6605 Scanner 
required different default 
values. 

The TAG 9 6604/6605 scanner 
required different initial setting to 
provide good image quality. 

The scanner diagnostics were updated to use 
the new default values and ensure that they 
worked equally well for the pre-TAG 9 
scanners. 

 

The following issues were resolved in 15.0 build 232. 

Issue  Description Problem Resolution 

SPAR 445463298 – Oversize 
PDF not scaled correctly 

A PDF file whose width was greater 
than the maximum width for the 
printer would only print the center 
section of the image which would fit 
on the maximum width media. 

Modified the PDF interpreter to accept and 
properly scale documents which are up to 
twice the width of the widest media supported 
by the printer. 

 

The following issues were resolved in 15.0 build 222. 

Issue  Description Problem Resolution 

SPAR 013732943 – Scan to 
PDF documents over 5 meters 
missing image. 

When a document larger than the 
200 inch / 5 meter limit was scanned 
a portion of the image file was 
blank. 

Corrected calculation of which portion of the 
image to include in the file to ensure that the 
full 200 inches of image are stored in the scan 
to mailbox file. 

SPAR 484671051 – Unable to 
get ftp files through Internet 
Explorer 

The FTP server behavior changed 
which prevented browsers from 
accessing the Accxes controller 
debug logs and scanned images. 

The FTP server was enhanced to allow 
browsers and ftp clients to access debug logs 
and scan to mailbox images with proper 
authentication. 

SPAR 062765217 – 6279 IIT 
NVM values displayed with 
wrong ID’s 

The listing of the IIT NVMs on the 
6279 included several entries with 
duplicate IDs which was confusing 
to service. 

The ID numbering has been corrected and 
some NVM settings were removed to match 
the IIT specifications.  The corrected set of 
NVMs starts with 710-028 and includes 029, 
032, 034, 036, 038, and 068. 

AutoDebugLogs  The service technician has been given the 
ability to enable and disable auto saving of 
log files to an attached USB drive at boot-up.  
The new commands are 
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Issue  Description Problem Resolution 

“enableAutoDebugLogs” and 
“disableAutoDebugLogs” 

 

The following issues were resolved in 15.0 build 213. 

Issue  Description Problem Resolution 

SPAR 684509918, 
502196319 – PDF files fail to 
print after a certain number 
of files. 

There was a memory leak in the PDF 
interpreter which caused PDF and 
postscript rendering to fail after a 
certain number of pages were 
rendered. 

The memory leak was corrected and the 
system has no problem printing large numbers 
of PDF and postscript pages. 

SPAR 364013898 – Can’t set 
FTP destination 1 to default 
for 6204.  

The Change Settings button on the 
6204 looks active for FTP 
destination 1, but it does not 
function.  For all other FTP 
destinations the Change Settings 
button is disabled. 

The Change settings button for FTP 
destination 1 was made disabled like the 
others.  The FTP destinations were never 
intended to be the default destination on 
6204, but are supported for 6279, 6604, 6605, 
6622. 

SPAR 186276607, 
206488000 – System would 
lock-up with feature timeout 
displayed or a blank screen. 

A problem with concurrent 
operations during a feature timeout 
could cause the system to hang or 
crash. 

The concurrency issue was made multi-thread 
safe which prevents hangs and crashes during 
feature-timeout. 

Duplicate fold program 
names caused problem with 
InstantAccxes folders. 

If a GFI folder with 2 identical fold 
programs was attached to an Accxes 
controller the Instant Accxes folder 
could not be enabled. 

Fold program names are forced to be unique 
when received from the folder. 

 

 

The following issues were resolved in 15.0 build 200. 

Issue  Description Problem Resolution 

SPAR 563893797 – 
Intelligent titleblock is always 
on for InstantAccxes jobs.  

The default setting for jobs 
submitted via InstantAccxes is 
“intelligent titleblock enabled” and 
there was no user control to change 
this. 

A new checkbox was added to the 
InstantAccxes configuration screen to control 
the Intelligent Titleblock setting. 

SPAR 694401598, 
434433822 – Insufficient job 
information displayed on UI. 

Status and out of media information 
was not being displayed on the UI in 
a timely basis. 

Corrected UI handling on the services main 
screen to display printing MIMIC when UI is 
not in use (after feature timeout) and after 
CLEAR key is pressed.  

SPAR 783484429, 
527239492 – Controller 
would not BEEP to indicate 
out of media condition when 

If mismatch queuing is enabled jobs 
which cannot print due to wrong or 
missing media are set aside to allow 
other jobs to print on the currently 

Added a BEEP when the media runs out during 
printing with mismatch queuing enabled.  The 
error screen does not display unless there is 
also a JAM.  Media requirements can be 
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Issue  Description Problem Resolution 

mismatch queuing was 
enabled. 

installed media.  Since there was no 
error displayed, no error beep was 
issued. 

obtained from the job info service or Web 
Printer Management Tool. 

SPAR 918175890 – Security 
tab confusing. 

The Security tab displayed 
configuration items for Immediate 
Image Overwrite (IIO) in a 
confusing manner making it difficult 
to know if it was or was not enabled. 

The IIO setting was changed to a checkbox to 
clearly indicate when it is enabled and 
disabled. 

SPAR 443408899 – Image 
loss during copy from 
wideformat scanner to 6279. 

When copying an A1 document on a 
6279 with wide format scanner and 
folder a small portion of the image 
on the trail edge of the document 
was lost. 

Page selection algorithms were updated to 
ensure that the correct media and image size 
for folding and non-folding cases were 
handled correctly. 

SPAR 662948697 – 
Thumbnail displayed off the 
screen. 

On the reprint queue page of the 
Web Interface thumbnails would 
display relative to the job they 
represented.  In some cases the 
thumbnail image would be 
displayed off the screen. 

The location of thumbnails was moved to a 
fixed position at the top of the Reprint tab to 
provide maximum viewing area. 

SPAR 358247318 – Restoring 
system configuration would 
not restore DHCP address 
correctly. 

When a CSE would restore settings 
for a system using “restoreSetup” 
the IP address would not be correct 
if the restored settings used DHCP. 

The “restoreSetup” command was corrected to 
properly handle DHCP addressing.  This script 
is on the 4.4 b 200 OS Installation CD. 

 

The following issues were resolved in 15.0 build 160. 

Issue  Description Problem Resolution 

SPAR 638916367 – Logo 
prints grey instead of black 

PDF interpreter issue Device colors are always used when processing 
PDF files with transparencies 

SPAR 683253388 – PDF file 
causes controller to stop 
rendering PDF files till reboot. 

Overly complex PDF files caused 
resources to be allocated and not 
freed which prevented future PDF 
files from being rendered. 

Corrected handling of complex PDF files to 
free resources when complete. 

SPAR 252268669 – Kanji font 
not printing correctly 

Kanji font pack was not part of the 
installation. 

Included Kanji font pack in this version of 15.0 
which explains the MUCH larger file size for 
the binaries of this release. 

SPAR 182031880 – CGM line 
styles different 

CGM line styles didn’t match the 
new line styles from Catia. 

Updated line styles to match Catia line styles. 

SPAR 908666306 – problem 
rotating slightly oversized 
plots. 

Often rotated plots that were 
slightly larger than the installed 
paper and clipped off an excessive 
amount of image. 

Corrected media and rotation selection for 
folding of oversize plots. 

SPAR 662948697 – 
thumbnails display off screen 

When reprint and thumbnails were 
enabled and the number of prints in 
the queue was more than a screen 

Corrected the display of the images to be in a 
consistent location near the top of the screen. 
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Issue  Description Problem Resolution 

full, the large thumbnail would 
display off the screen. 

 

The following issues were resolved in 15.0 build 151. 

Issue  Description Problem Resolution 

SPAR #281771787, 
878881393 – Instant Accxes 
does not print after printer 
goes to sleep. 

After an extended sleep of more 
than 2 days the Instant Accxes 
folders would not print any 
document placed in them. 

The InstantAccxes function is now woken up 
with the printer or the placement of a 
document in the folder. 

SPAR  #908666306  Oversize 
TIFF gets rotated and clipped 
when folding 

Any document which was wider and 
longer than the width of the largest 
roll installed would get rotated 90 
degrees and clipped when folding. 

The media selection and rotation algorithm 
was enhanced for non-PDF documents to 
properly orient oversize documents. 

SPAR #429951410 – DC 361 
not working on 6279 system. 

Service diagnostic DC 361 would not 
save or restore settings. 

The service diagnostic DC361 was fixed to 
properly save and restore to/from USB and 
HDD. 

SPAR #898891710, 
885670316 – DC 361 not 
working on 6604/5 

Service diagnostic DC 361 would not 
save or restore settings. 

The service diagnostic DC361 was fixed to 
properly save and restore to/from USB and 
HDD. 

SPAR# 088778871 – media 
size detection for 841mm 
paper was too restrictive. 

Media which was reported by the 
printer as 843 mm was treated as 34 
inch paper instead of 841mm. 

The paper mapping was adjusted to be more 
forgiving for reported media of all sizes. 

7142 printer would crash if 
the mismatch mode for any 
media was set to 
SUBSTITUTE by ACT. 

Accxes doesn’t hand SUBSTITUTE 
for media mismatch on 7142 and 
failed to properly reject the setting. 

If any mismatch mode is set to SUBSTITUTE it 
is now ignored. 

The latest version of Acrobat 
would report preflight errors 
against scan to PDF 
documents. 

The PDF/A documents are PDF/A-1b 
compliant, but reported themselves 
to be PDF/A-1a compliant. 

Scanner  PDF files are now identified as 
PDF/A-1b compliant 

Random scan inversion during 
a multi-page scan. 

Occasionally during large multi-page 
scan sets the image inversion would 
turn on by itself.  This was found to 
be caused by a buffer overrun which 
randomly affected the invert setting. 

The buffer overrun was corrected and the 
image invert feature no longer turns itself on. 

DWF files caused system to 
hang. 

DWF rendering engine failed to start 
causing the system to wait 
indefinitely 

DWF rendering engine start-up issues 
addressed. 

Large ACT job hangs system. Jobs that contain many files 
wrapped in PJL were causing hangs 
while parsing the PJL between files. 

Corrected PJL interpreter to properly handle 
interfile PJL in large concatenated jobs. 
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The following issues were resolved in 15.0 build 140. 

Issue  Description Problem Resolution 

SPAR #127271420 – DWF 
File hangs in Processing 

DWF rendering of certain elements 
was VERY SLOW requiring hours to 
complete the page. 

Rendering of these elements was sped up to 
improve processing time 10 to 20x for these 
elements. 

SPAR# 281771787 – Instant 
Accxes was non-functional in 
sleeping system 

If a system went to sleep for an 
extended period of time (>48 hours) 
the Instant Accxes folders would 
print files placed in them 

A mechanism was installed to keep the folders 
active while the system is in deep sleep/power 
saver 

SPAR# 513219677 – Accxes 
print driver changed in total 
Accxes 

The underlying driver in Total Accxes 
for the “Freeflow Accxes” entry was 
changed and was no longer usable 
for other printer types. 

The HPGL driver which was used for Accxes 
was added back into the list as an “HPGL” 
print driver. 

SPAR#374032304 – Server 
crashed while printing LZW 
TIFF files 

An odd use of LZW compression in 
these TIFF files cause Accxes to 
crash. 

The TIFF interpreter was updated to handle 
these odd uses of LZW compression. 

SPAR# 726603182 – Media 
type note saved in template. 

When saving power on default 
template settings on a Wide format 
Scanner the media type was not 
restored when the system had a 
different media type in roll1. 

Timing was modified to ensure that on 
Celeron based systems the media type was 
restored correctly even when only the last roll 
contains the saved media type. 

 

The following issues were resolved in 15.0 build 136. 

Issue  Description Problem Resolution 

SPAR #882283326 – PDF 
scaling down of fine lines. 

Scaling down fine lines with 
minimum line width set to more 
than 1 pixel produced unusually fat 
lines. 

The fine line calculation was corrected to 
produce the correct thickness of lines. 

SPAR #051708141 – DWF 
files show completed, but 
nothing prints 

Certain DWF files were not properly 
interpreted. 

The DWF interpreter was upgraded to properly 
support these DWF files. 

Streamed DWF and PS/PDF 
files did not print correctly. 

When PS/PDF or DWF files were 
streamed to the server without file 
separators only the first page was 
printed. 

The server was updated to better identify the 
start of PS/PDF and DWF files in streams.  

 



 

 

 


